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Hello, this is Eric Bobrow. And in this lesson we'll take a look at how you start a project. Do you use
lines, fills, the Zone tool, draw walls immediately, or create a massing model? The answer | think is that
all of these are legitimate ways to start a project.

Let's take a look at a blank screen here with a project that hasn't been started and I'll just pan over to
the side to give myself some space. And I'll use the Poly Line tool to create let's say what might be the
property boundaries for this project. So I'll just draw a line, and I'm going to do it off the axis to make it
a little bit more tricky. and let's turn on the tracker so | can see distances. And let me make this a nice
even 100 feet, that would be about 30 m. And I'll take it up to perpendicular. To go perpendicular, I'm
going to go along this edge that | just started and you'll notice the orange dot. I'll click on that, that'll
make ArchiCAD create guideline at that angle. And then I'll take it up to where it gives me the
perpendicular snap. You can see just above the pencil is this little symbol of the perpendicular.
[0:01:16]

It may be a little bit different if you're working in ArchiCAD 10 through 14 to do this. But | just noticed
this particular trick, so | thought | would share that. | will take this up say 75 feet here and then perhaps
go at an angle parallel to the front but maybe make it a little bit shorter; make it 70. and then close it off
here. So there's a boundary. It's a small lot, but certainly one that you could put a building on. Let me
just select this poly line and change it so it has a dash. We will use the long dash so we can see it. And I'll
just zoom in a little bit. So all of that was to set the stage for what might be a certain context where
you're going to be drawing the building. [0:02:07]

Now sometimes the building design is really determined by the setbacks. So you can only be a certain
distance or no closer than a certain distance from the property lines. So how would you actually
determine those setbacks? What is the quickest way to do that? Well I'll use the Poly Line tool and I'll
use the Magic Wand. | will go ahead and press down the space bar to get the Magic Wand and draw
another poly line right on top of it. So you'll notice that as soon as | clicked | now have two poly lines
and | can select one of them. You'll notice that by pressing down the Shift Key, it highlights one and it
tells me that it's a poly line with the dashed lines. [0:02:51]

And if | hit the Tab key, it will select the other one which is the one with the solid lines. Now there's
really no difference between these except for the line type. But I'm going to take one of them and
offset it. So I'll press down on the corner having selected it, and in the pet palette | will use the option
that's in the top row that says to offset all sides. And now when | do that, | can make it bigger or
smaller. And the Tracker will show me the distance that I'm moving in. So let me take it, just because
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the size of this is relatively small, I'll make it as a small distance say 6 feet which would be about 2
meters. Take that in. [0:03:29]

So at this point | have some lines that | could use as guidance for setbacks. Maybe | will make these a
dotted line so that they stand out a little bit differently, and I'll zoom in on it. So now we can see the
setback lines that I've got. Now suppose that this front side actually needs to be further back. In other
words, instead of 6 feet, it needs to be further. I'll press down on the edge instead of the corner and use
the pet palette options to offset just that edge and take that in another 4 feet so that it would be 10 feet
from the front of the building. And perhaps do the same in the back. [0:04:08]

So | can easily go and use that offset on all sides to get a uniform offset and then change the offset on a
particular sides by doing this. So this is a way to get your boundaries of what you can work in. Now
sometimes you need to have extra lines or extra offsets just on one side, and so poly line won't do. So
what I'll do is simply go to the Line tool and perhaps I'll draw a line across here. And this line I'll then
select. Now by the way | can go to the midpoint of the line and it will select the line. Actually, in order to
select the line, rather than the poly line, simply by using the Shift Key and selecting, it will find the line
first rather than the poly line, because I'm in the Line tool. [0:05:00]

So activate the tool that you have and then use the Shift Key and that will prefer it. Now I'm going to go
ahead and take this and move it. Now you can use the Arrow tool or in most of the later versions of
ArchiCAD you can just have the Drawing tool active as long as you've selected it and press down. And
one of the options in the pet palette would just be to drag. Of course when | drag it, | want to make a
perpendicular, | don't want it to go up in this angle. So will it be sensitive to that perpendicular? Well if
| go along this edge and click on that orange dot, or simply stroke it in previous versions of ArchiCAD
where we get the orange dashed lines like this, then we will have sensitivity to the perpendicular. And
you can see that as | move this, that the guideline shows up. [0:05:52]

Let's see if | can get that again. The guideline shows up with a perpendicular symbol and | can say that |
want to make this a 5 feet further in. So this is now an extra line. So sometimes you obviously have
multiple different types of setbacks. Not just a single one on each side. Now for trimming, as a quick
shortcut, if | zoom in on this and | hold down the Command or CTRL key, | get the scissors. And then |
can go to the edge of the wall line that is outstanding and click and it will trim that off. You can see how
that happened. And | can go of course and select this line and perhaps change its line type to make it a
little bit clearer for our purposes. [0:06:37]

So these are some ways that you can quickly create some offsets. I'm going to show you actually a
faster way to do both of these, and even go further. So let me go and copy this outline. So I'll just zoom
out a little bit and drag a copy. So I'll say drag it using the pet palette, drag it over to the side, and then
I'll press and release the Option key on the Mac. You can see a tiny little plus sign show up next to the
cursor. It would be the CTRL key on Windows that you would press and release. And then I'll just take
this over a couple 100 feet to just get myself some space. And I'll zoom in this area. So | had Magic
Wanded this area and then separately selected the lines and offset them. [0:07:31]

2 Best Practices Course — Week 11 Part 1 — © copyright 2012 by Eric Bobrow



But let's see how we can do this all in a single step using the Window menu, Palettes, Control Box. So
the Control Box is a palette that used to be standard for ArchiCAD. In other words, in versions of
ArchiCAD up through version 9 | think it was just one of the standard palettes that you would always use
and you certainly needed. Starting with version 10 | think it got demoted, meaning that although it was
available, it just wasn't showing by default. And many of the controls are available up in the toolbar. So
in other words, this tool bar right here that I'm highlighting and moving around has things like the group
and ungroup or different things for grouping and some of the other controls. But still there are some
unique things about the Control Box. [0:08:26]

For example, to draw a line perpendicular to another line is sometimes a little bit simpler using this tool.
| can click to start a line, then use the option for perpendicular snapping here, activate that. click on the
edge of this line. You'll notice the cursor has changed. | think that's actually is a little bit more clear
than it used to be. In other words, this little extra symbol that is floating alongside lets me know that
I'm about to click on a perpendicular line. But you can also look down at the status bar down at the
bottom left, click reference edge or draw reference vector for parallel angle. So it means that I'm going
to click on something like this, and now you can see I'm constrained to creating something
perpendicular to it. [0:09:14]

And | could of course snap it to that line or | could take a short or long and know that it's actually
perpendicular to the line that I've indicated. So this is one of those snap options. There's perpendicular
and parallel. The parallel would allow me to make sure that I'm drawing a line parallel to some other
line. These can both be used. You can get a similar effect with the guidelines, but the angle bisector is
another one that is unique here that you can use in some cases. You'll actually select two different lines
and then it will constrain you the line that would bisect that angle. But the one I'm going to actually
show you and focus on is the single offset and multiple offset. So if | say single offset, then when | draw
- and let's say | use the Magic Wand. And you'll notice that there's actually a Magic Wand icon here. This
is the only place where you can find the Magic Wand as an icon as opposed to just a using the space bar.
[0:10:19]

So if I click the Magic Wand and then click on this the edge of this line, the combination, the Magic
Wand says trace this, so traces those four boundary lines. And the offset says, don't actually complete
the operation until | tell you how far in or out | want it to go. So let me just take it that same 6 feet and
it works there. So let me repeat that. I'll undo the last couple of steps here. So I'm going to go click on
this icon of the offset to say the next thing | draw will be an offset from wherever | am indicating. In
other words, I'm going to indicate a home position and then tell it how far to offset it before it
completes it. And I'll use the Magic Wand to say I'm going to, instead of drawing it manually, I'm going
to draw this by tracing it. [0:11:15]

So I'll click and then move in 6 feet. Now let's say that | wanted to do an offset just on one side. And
what | could do is activate the offset and instead of using the Magic Wand, | can go click on these two
points. And then when I'm finishing the poly line, the multipoint line, and then it says well how far do
you want to go? So | can go say take that let's say 4 feet in. So basically the single offset one will allow
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me to manually trace one or more line segments or use the Magic Wand. and then it will assume that |
want to offset it from there. So this is a great shortcut particularly if you're doing many different similar
offsets. [0:12:05]

Now we can also do multiple offsets like this. So what that does - and I'll just use the Magic Wand. I'll
just press down the space bar to get the Magic Wand, that's another way of course. Now I'll just take it
out once and twice, and a third time. And you can see each time it gives me distance from the original
point. So | can type in let's say 25 feet outside. So I've now created a series of, in this case outer offsets
as opposed to inner ones. And when I'm done, | just hit the escape key and it completes the operation.
So this multiple offset one will allow you to create obviously a series of concentric lines or arcs.
[0:12:52]

It will work with arcs as well or poly lines that have arc segments without a problem. So this is a great
shortcut in certain cases. So let me just undo back these offsets here, and show one other little shortcut
that | think is nice. If | select this line here, you know | can go and use the adjust button here in the
toolbar that says adjust and then go click on this edge, and that will extend it. But | can also just simply
hold down the Command key. And when | hold down the Command key and then click, you'll see it
extend to that or shorten or splitit. [0:13:36]

So you can see that - I'll just back up the last couple of steps and say if it's short and | hold down the
Command key and click, it will extend it. And I'll go ahead and extend it further. Ifit's long and | hold
down the Command key and click, then it will split it. and this was actually acting much like the split
button here. So that Command key is the CTRL key of course on Windows. And just be aware that this
only will work if you're in the tool that matches the element. In other words, if you have a line, you have
to have the Line tool active or if you have a poly line | think that you have the Poly Line tool active. So
this is a nice shortcut for extending things. You can even use it with the Wall tool. For example, if | have
a wall here, and another wall, and | select this one wall and | have the Wall tool active, | can
Command-+click and extend the wall to meet it. [0:14:38]

Or if a wall is going beyond something like this, | can select it and Command-+click and it will split that
wall into two pieces. So these are all shortcuts that are nice for speeding up your work. So I'll just go
back. And remember that you need to have the tool active that owns the element. In other words, the
Wall tool if you're working with walls or the Line tool if you're working with lines. So let's go back to our
previous view here. so we have an area here. | wonder how big this is in terms of the lot size. So one of
the things that of course can make a difference when you're designing is to know the amount of the
area for the lot and how much area you're allowed to put down for the building, the area ratio may be
an important part. [0:15:36]

So I'm going to scroll down and actually go in the 2D tools, the Document tool and activate the Fill tool.
And when | activate the Fill tool | could use any type of fill. I'll just use the 25% so we can see a nice,
little wash of color. But what | will do to change it from the default here is I'm going to go and scroll
over in the Info box and click on the option that says Show Area Text. So when | do that, if | go and let's
say use the Magic Wand to click on this, you'll see that it drew some lines around it. We do see a visual
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change as it traced the outline. And then there's the hammer icon. And when | click on that, you can see
a tiny little indication of something being placed there. And when | zoom in on it, you can see that it
says a certain square footage. [0:16:29]

This would be an area square footage or square meters that you would see. Now I'm going to select this
text here - it has one handle in the bottom left corner of it - and change its size. so it'll just be easier to
read. | will make it 30 points size. So it'll be easier to read when we're working on different things. So
that's an overall gross area. And of course | could select this text and literally just move the text. If |
move the fill, for example, if | select this fill and drag it, then the text moves along with it. Let me just
undo back. But | can move the text independently of the fill just for clarity sake. [0:17:17]

Now I'm going to go and eyedrop the text item here. And this actually sets up the Fill tool so the next
time | draw it, it will use the same settings. In other words, have the same size text. Because I've
eyedropped to pick up the properties. Now just to make it a little different looking, I'll change the color
say to a darker blue, and then I'll use the Magic Wand and trace this. And you can see that | just created
a fill automatically in this area, and it says how much this area is. So obviously if we start designing a
building and we draw a fill - let me just do a polygon shape just to make it arbitrary. So if | have created
a building shape and I trace it with the Fill tool, then if the Fill tool is set up to show area text, we can get
some reporting on that. And that certainly can be very important for just optimizing your design in
relationship to the property area. [0:18:25]

Now it is possible to get reports on these things. We're going to look at that in the next lesson when we
look at room lists and area calculations as a whole. Now these fills are purely 2D. And there is another
option that can give you some similar feedback for square footage or area; that is the Zone tool. Now
the Zone tool, some of you perhaps have used it quite a bit and others. Let me just show you the basics
of the usage of the Zone tool. I'm just going to draw a little building here and create a few partitions.
And so just create say a couple of similar ones here and then another one going across. So now I've got
four different rooms. They don't have any doors yet, but let's go ahead and look at what happens when |
activate the Zone tool and tell it to create some zones in this area. [0:19:40]

So | will zoom in on the little building that | started to work on, and we'll look at the Zone tool. The Zone
tool has geometry options of manually placing its boundaries, automatically find in the boundaries of
the walls, or finding the boundaries of the reference lines of the walls. | will use the one that says
automatically find the - essentially the inside faces, the closest edge of the wall. And | will go ahead and
click. And as soon as | click, it finds this area and it's prepared to drop in a stamp. You can see the little
hammer icon. And when | click on that, you can see that something is drawn in, let me zoom in on it.
You can see it says "Room 001", and has a certain square footage. So it's sort of similar to the Fill tool in
that it's immediately reporting square footage. [0:20:32]

I'm going to go ahead and select the stamp here and let's look at its options. So the stamp is essentially
just one part of the zone representation. The zone has a category, so you can actually categorize
different types of usage. And these are fully customizable in the Options menu, Element Attributes,
Zone Categories. So that gives it its color as well as a name. It has the name of the room which of
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course could say kitchen or bathroom or office, and then it has a number. So if you are doing a
commercial building, of course you would probably have numbers for all the rooms. In a residential one
you might ignore that. And interestingly, it has a height. And we're going to look it that a little bit later.
[0:21:21]

But just for now for clarity, I'm going to go and just make the size of this a little bit bigger. So the size of
the text here - let me make this bigger for the room name - and then the size of the elements below it
which have the room number and the area, | will make that quite a bit bigger as well. We can see them
now almost come up to the same size. And there are various options, depending on which zone stamp
you're using. So zone stamp is supplied. There are a number of them supplied in the standard ArchiCAD
library. You can choose - and some of them have different options. So in this case | might say that |
don't really need the zone number, so I'll turn that off, but perhaps | want to say that I'd like to show the
ceiling height and perhaps show the volume. [0:22:14]

And so you can see all of these numbers now being reported. Let me say OK, and you can see how this
now is displaying all of that information. So I'll use the eyedropper to pick up the settings of this. And
that means that when | do the next zone, it will have a similar setting. I'll just go ahead and click here
and drop it in. And you can see that it's got almost the same square footage. | made a similar size. And
certainly the same height that was just a setting within it is the same. Now what happens if we change
the color of this? | can go ahead and say change it to mechanical, and then click, and you can see that
it's now got a different color. And that also can be totaled up later in terms of how many rooms of what
types and total square footage for different usage. [0:23:10]

Now if | were to manually change the room boundary, let's say that | moved this wall in a little bit and
then took this wall and stretch it. So now I've changed the shape of the rooms. Now the zones did not
automatically adjust. They were created originally from the room boundaries, but they didn't
automatically adjust. Now we can make them adjust. We can ask them to adjust by going to the Design
menu, and we'll see that there is an option here for Update Zones. So when we bring up the Update
Zones here, we can say that we'd like to update all zones, or we perhaps could select one or more to
focus that. When | say update all zones, you can see how instantly these zones adjusted. One got
smaller and one got larger. [0:24:11]

And you can see that there's some reports here in terms of these zones that this particular room here
got smaller, it's 80% of its original size. This one that larger. We can also flip it to say added square feet.
And you can see this room lost 1 14 square feet. This room gained it. So basically, the reason why zones
are updated manually is that ArchiCAD allows you to do manipulations on room boundaries and then
when you're ready, you can update the zones and see the results. So it allows you to analyze the effects
rather than just having it automatically be updated. Now that was quite visible, and certainly not a big
surprise once you understand the option there. But let me show you something. If we were to use the
Marquee tool, and let's say that | were to take a boundary around this area and then change the size.
I'm going to go ahead and change the size. [0:25:20]
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And as | do this, look at the room square footage on the left side. In other words, the second room
which says 460 square feet. As | click to stretch this, you'll notice how everything is adjusted. The colors
look beautiful. The color of the zone adjusted along with the walls. But it still says 460 square feet.
Obviously that has not been updated. So what we need to do is either select it and update just that one
or click again update all zones. And then you can see how the square footage adjusted. And the zone
stamp actually moved over to stay centered. The zone stamp can be set to stay centered in the room or
to move to a different position depending upon some parameter settings. So that's the basic of using
zones, at least for getting certain reports. [0:26:17]

Let's take a look - and I'll just get out of the Marquee tool - let's take a look at what we've got in 3D.
Now the reason why I'm doing that, I'm going to go to 3D right now, and we'll close the Update Zones
for now. And let's just orbit around this. You can see that I've just got the basic shape of the walls,
because everything else | did was 2D. Now the zones, if we go to the View menu, Elements in 3D View,
there is an option called Filter Elements in 3D, which | would say a lot of users are not aware of. When
we bring that up, we're going to see some different controls. You can actually turn off certain
categories. You can turn off doors and windows for example. Sometimes it's nice to do that. [0:27:09]

If you want to be able to get a quick view of a complex building, it will show the cutout for those doors
and windows but will not render the actual GDL objects. So it will go much faster. On the other hand
you'll notice that there is something called "Zones" here that is unchecked. So let me just say show all
types, and now the zones does get checked. And when | say OK, we're going to see there's actually some
contents, it sort of looks like water. If | select one of these zones, and you can see that it is an object or
an element that | can select, and it says that it's a zone. When | open up the settings, one of the options
is the model settings here. And in the model settings, it says that the material is "Glass Blue Ice".
[0:27:59]

So it's just basically a volume that has a particular material for visualization. Now the reason why this is
important is you can do various studies here for volume. Sometimes that's going to be important for the
building. And you can also use the zones for some massing studies. So | can literally go and change the
height of the zone either by typing in a new height, I'll just say 20 here, or just visually doing that. And
you can see how the zones now as | orbit around, we can see the shape that we are creating. Now this
zone literally doesn't have to be see-through. That's a very nice default to allow it to be seen in the
context of the walls or the existing building. But we can go in and change the material say to just
something ordinary. [0:28:58]

And I'll just make this let's say a paint color. so I'll just give it a particular color and then say OK. And you
can see that now it's actually opaque just like any solid volume. So just because it’s a zone doesn't mean
it's translucent, it was just using a translucent material. So what does this mean? It means that you
could use the Zone tool not only for areas and not only for volume calculations, but you can also use it
for some massing studies. So obviously sometimes you're going to want to do some massing work to
work out a design. [0:29:38]
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Now, a common use of zones - and I'll just undo back here to where it's within the building - a common
use would be to total things up as you have a complex building with multiple stories. And you might
actually have the zones show up by themselves to indicate the usage areas. So I'm going to go and
quickly create an example of that. So let's say that I'll go and pick a different zone type, let me go and
eyedrop this and then pick a different zone type for let's say clarity, just a different color and put that in
here. So now I've got three different types. And let's go and select all of these here, copy them, and I'll
go to the second floor or the story above and paste them in. So now I'm going to have two stories that
have the same information. [0:30:39]

But perhaps on the second story I'll get rid of these two zones, and perhaps lop off the side of the
building. So I'll go and select these two walls and delete them and then I'll use the Command or CTRL
key to get the scissors and trim off the axis. So now the building obviously will have two stories, but the
upper story is much smaller. And so | will go to 3D, and you'll see that | now have a little bit of a building
shape. Let me just zoom out a little bit. Now I'll go switch my view in the elements in 3D view with the
filter elements to say | will turn off everything and just show the zones for example. And now when | say
that, we can see these zones stacking. And perhaps if | select these two zones, | might change their
material. And so let's say that the material inside of glass blue ice, let's take it a glass tinted dark. So this
is a little different color. [0:31:47]

And you can see that the usage areas are starting to be visible in this 3D view. So imagine that you were
designing and you wanted to be able to communicate that certain areas of the building were public
spaces and certain were for storage and certain ones were for private residences or things like that. You
could easily create these zones to not only give room names and square footage but also in a 3D view
show sort of the proportions and layout and what types of use were in proximity to which other ones.
And obviously sometimes that's going to be very important. You can have certain elements or certain
usage near certain other things, and then sometimes you don't want to be close. You don't the sanitary
facilities to be next to - in an operating room or something like that. There's going to be some rules for
what areas can be close to or need to be further away from each other. [0:32:57]

So this is another part of your design studies that you can use is the Zone tool. Now this type of a
stacking and model could be done with other tools as well. For example, if | go back to the floor plan
and go down to the first floor, let's just draw with the Slab tool. So if | draw a slab, let me just arbitrarily
draw something here, and I'll just stretch it to be adjoining. Stretch this edge to be adjoining that
building here. And we go to 3D. Now of course | turned off the slab, so it didn't show up. So let me go
to that the View menu, Elements in 3D View, Filter Elements, and there is a keyboard shortcut which
you can use if you're going to go back and forth. And let me say Show Slabs. [0:33:53]

Now the slab is just a small platform but of course | could go here and change its height using the pet
palette and take it up let's say to 40 feet. So let's say that it was going to be a bit of a tower, or just a
much taller part of the building structure. So as a slab, we can do various things. We can curve the
edges, whoops | grabbed the wrong edge here. That's interesting. Let me take this edge and pull it out.
Okay, so | need to take it from the top if | want it to be something like that. So we can start working
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with massing with slabs. So without taking the time to demonstrate it, obviously you could create a
number of slabs of different sizes representing 1 story, 10 stories, and 4 stories; and different colors
representing different usage or different exterior treatments. [0:35:01]

So in terms of creating your building design, if we go back to the floor plan and just sort of take a quick
review, sometimes you're going to want to work with lines and offset lines to get your limits for the
building. Sometimes you're going to want to work with square footage in it and use the Fill tool either
after having drawn some walls or building design or beforehand. And you can instantly get feedback for
the square footage of the lot or the area of the lot and the area of the whole building or parts of a
building. And you can also use the Zone tool. And in the Zone tool, you can do this as | showed inside
the walls or something | didn't show is that you can activate the Zone tool. If | go back to the Zone tool
you can actually manually draw an area. So one thing that is a little awkward is you can't just draw a
box. You can draw things - say | will make it 15 feet, about 5 meters, and take this over 10 feet, about 3
meters. [0:36:16]

| have to draw each side individually, so I'll just use the snaps to make it nice and square. But this zone
here - and let me just pick up the settings with the eyedropper of this one and then inject it into that
one - so this zone here, | will again put it back to being a manual outline. That's what that warning
message came up, it was telling me essentially that there was - | was switching it to the settings that |
had for the other zone which had a boundary. In any event, we can create these bones to represent a
particular room type. And let's just say that I'd like to multiply this. So I'll just multiply this and say create
six copies along here. So this now becomes something that | can move around. So | could take these two
and drag and up into this area here. [0:37:23]

So we can actually draw some zones even beforehand. And of course | can draw another one let's say
draw zone here, and I'll just do this by eye. And so we can actually have this, and let me just move the
little stamp to put it inside it. Actually I'm getting the corner. | want to move just the stamp, so I'll grab
one of the corners of the stamp. So we can certainly set up in terms of designing a building, you can
preset that you need so many offices or classrooms of a certain size. And we have other rooms for
meeting rooms or cafeterias or lobbies or other things like that. And you can basically create these little
pieces of paper that you can shuffle around and change their shape and make sure that your meeting
certain program requirements in terms of square footage or area that will suit your client's needs.
[0:38:40]

And then as you rework the buildings of perimeter and arrangement, you can see this sort of as a bubble
diagram. And so this can be used just by itself or of course we can take a look in 3D. And when | look in
3D, we're going to see that we now have this new group of elements here. And the 3D that we've
created even without the walls, we can still stack them up on multiple stories. So you can easily have
the zones creating the building for analysis to say how are we meeting the program requirements. We
need 82 offices. We need 14 meeting rooms. We need so many restrooms and things like that, sanitary
facilities. [0:39:31]
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So this is another alternative for starting your design is using the Zone tool just in isolation. Now the
final thing I'm going to show you here is we were working with lines here and we were working with
walls there. If we were working on a residential project, sometimes I've seen people do things with the
Line tool or the Poly Line tool. And let's just say that | wanted to create a little building design. So I'll just
simply draw a series of lines and create a shape. So this is a series of lines, and perhaps we're going to
have something going off here. And then closing it off that way. and perhaps | will have a corridor going
along a certain space. And I'm just sort of sketching this of course. And so I'm actually creating perhaps
a basic concept for the building. [0:40:38]

And some people say that they want to do it with single lines, because they don't want to worry about
thick the walls are or what type of walls and things like that. Well of course, this we wouldn't see in 3D
at all. If we use the Wall tool, | would say that probably a lot of users have not tried using it with zero
thickness. But you can very well use zero thickness. So I'll just sort of do something very similar to what
| created a minute ago, I'll just draw some walls. Actually, let's draw them with a poly series of walls.
And so I'll just draw this across. And of course | can sketch it totally by eye or | can use numeric input to
say that | want it to be a certain distance. [0:41:30]

So here we have a boundary of some walls, and | will go ahead and put in something similar. So these
look just like lines. If | zoom in on them, they have no thickness. They are little bit thicker on screen.
They standout nicely because | have a setting turned on by default in the View menu in the Onscreen
View that is called Bold Cutlines. If I turn that off then we'll see this looks much like any other line. But
with the Bold Cutlines it makes walls and certain other elements stand out a bit. So the difference here
in when | go to 3D, we're going to see that these walls or this area - actually | have turned off the walls in
the elements I'm showing in 3D. So let me just say show all of them. [0:42:29]

And now when | do that, and say Fit in Window, we can see here is the walls that | just drew that have
zero thickness. And so | can draw them just as easily as | could draw a line, but they are walls. And we
can start looking at them in 3D. And if at some point we are ready to actually start looking at volumes
and spaces, we can select these walls and change their thickness. So I'll just give them a nominal
thickness, and you can see them all immediately thicken up. Now when | go back to the floor plan we're
going to see a little bit of a problem and that is that the wall thickness faced the wrong way or let's say a
different way for this interior wall and for the exterior wall. [0:43:16]

But | can just select the wall and switch its construction method, and you can see how it flips over and
now matches. But basically, you can draw, instead of assuming that you need to draw lines to make it
simple, when you want to just sketch out a concept of where the rooms are arranged, why not draw
walls and just perhaps make them zero thickness or give them an arbitrary thickness and then know that
you can adjust the thickness at any time. Of course this allows you to put in doors and windows and
other things as part of your concept study, which you couldn't easily do when you're working with the
Line tool. [0:43:56]

So this concludes our lesson on starting a project. And the question that | posed was do you start with
lines or fills or zones, walls? Do you do a mass model? And the answer is yes. Whichever one suits your
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needs best, | suggest that you become familiar with as many of these options as you can, perhaps some
of them are unfamiliar like working with the Zone tool and you may want to play around with that and
see how that works and apply it when it's appropriate on your next project. So this has been Eric
Bobrow, | thank you for watching and | look forward to your comments and questions on the page down
below.

[END OF AUDIO 0:44:44]
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